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Micro Focus Academic Program 6.0 -
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Overview

The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.

COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.

The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.

This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.

Welcome! We’re excited to have you join our growing academic community.

Product Description

The Micro Focus Academic Program Edition package comprises the following products:

• Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.

Variants of Visual COBOL include:

• Visual COBOL for Visual Studio 2017 or Visual Studio 2019
• Visual COBOL for Eclipse (Windows)

• Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:

• Enterprise Developer for Visual Studio 2017 or Visual Studio 2019
• Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:

• You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.

• An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.

For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.

Reporting Issues

• For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Documentation Web
site for any updates to the documentation which might have been uploaded.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.
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• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 6.0 release.

Enhancements are available in the following areas:

• .NET Core
• Application Workflow Manager
• Building Applications
• CICS Support
• COBOL Application Console Size
• COBOL Language Enhancements
• Code Analysis
• Code Analyzer Refactoring
• Compiler Directives
• Containers
• Database Access - DB2 ECM / HCO for DB2 LUW
• Database Access - OpenESQL
• Database Access - XA Switch Modules
• Data File Tools
• Debugging
• Deploying Applications
• Eclipse Integration
• Enterprise Server
• Enterprise Server for .NET
• Enterprise Server Security
• Enterprise Server Common Web Administration
• File Handling
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Library Routines
• Micro Focus Database File Handler
• Micro Focus Unit Testing Framework
• Microsoft Build Tools and Windows SDK Configuration Utility
• Multi-Threaded Applications
• PL/I Support
• Product Documentation
• Visual Studio Integration

.NET Core
Back to Top

Support has been added for .NET Core 3.1, and a number of new .NET Core project templates have been
added.
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Note: Because Visual COBOL requires .NET Core version 3.1 and .NET Core version 3.1 is not
supported by Visual Studio 2017, you must be using Visual Studio 2019 to be able to use Visual
COBOL to create COBOL applications to be deployed for use with .NET Core.

Application Workflow Manager
Back to Top

Improvements have been made in the following areas:

• REST modelling - the REST function package now supports the following:

• HTML formatted text fields.
• Copying and pasting of JSON format template into a JSON structured file descriptor in the AWM

model editor.
• Specify a general status code handling, which is applicable for all tools from the REST function

package.
• Handling loops when specifying a status code handler.
• Uploading and downloading text files to and from a REST based application.
• Automatic retrieving of valid values for a dialog input field without the need to click Retrieve.
• Auto-completion in dialog input fields.
• Specify clearing dependencies between dialog input fields.

• Local Java development - the following features supporting local projects for Java development have
been added:

• A Java function package with the corresponding property, element types, and tools
• A sample AWM model for local Java development

• The function package developer guide now provides more details.
• AWM extension templates are now available
• AWM model editor improvements:

• The AWM model properties now only display the relevant attributes in the Properties view.
• Auto-completion of fields which enable you to specify property references.
• The Used by dialog now displays property reference usage.

Building Applications
Back to Top

This release includes the following new functionality:

• Compiling Mainframe Subsystem Application projects in Visual Studio now continues on error - all
compiler tasks for the different file types will now continue to run, if one of the tasks reports an error.

• Maven build support in Eclipse - you can use the Apache Maven support in Eclipse to build COBOL
JVM projects and COBOL JVM Unit Test projects.

CICS Support
Back to Top

This release provides the following enhancement:

• Viewing CICS PCT Resources inside Visual Studio (Technical Preview)

You can now view CICS PCT resources from within Visual Studio. You can do this with the help of a
context menu command, Show CICS Resources, for an enterprise server in Server Explorer.

A context-menu command, Create PCT, is available in Solution Explorer for COBOL programs which
are part of a Mainframe Subsystem Application project associated with an enterprise server instance.
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COBOL Application Console Size
Back to Top

The maximum console size of a COBOL application has increased. It can now be 255 lines by 255
columns, configurable using the screen_lines and screen_cols run-time tunables.

COBOL Language Enhancements
Back to Top

The following enhancements are available:

• Enterprise COBOL 6.2 Update - new syntax, library routines, and the respective analysis tooling are
available for compatibility with IBM's Enterprise COBOL 6.2 Update:

• New intrinsic functions are supported: BIT-OF, BIT-TO-CHAR, BYTE-LENGTH, HEX-OF, HEX-TO-
CHAR, NUMVAL-F, TEST-NUMVAL, TEST-NUMVAL-C, TEST-NUMVAL-F, and TRIM

• A number of intrinsic functions now support national data (especially surrogate pairs): REVERSE,
ULENGTH, UPOS, USUBSTR, USUPPLEMENTARY, UVALID, and UWIDTH.

• A LOC phrase has been added to the ALLOCATE statement to define whether memory is allocated
above or below the 16MB line.

• CONSTANT qualifier - it is now possible to define data items as constants. This improves the code
readability and usability, and helps detect programming errors. The ability to create constant items is
already in .NET COBOL and JVM COBOL, and many other languages.

• Local variable declarations in native COBOL - it is now possible to declare data items inline in the
code and not only in a separate DATA DIVISION. This provides better locality of data, making the
source code easier to reason about.

• Native data type to hold strings of utf-8 characters - in native COBOL, support is now available for
the PIC U data type as introduced by IBM in Enterprise COBOL version 6.3. Direct support is available
for utf-8 data.

• Performance improvements - this release provides various performance improvements, most
significantly on 32-bit Intel x86 platforms. When using the highest optimization level, opt(4), the
performance of native code generated by the COBOL Compiler has improved. A number of cases are
affected, most particularly those where it is beneficial to locate PERFORM ranges inline.

Code Analysis
Back to Top

Support is provided in Visual COBOL for accessing the Application Analysis Server which is part of the
Micro Focus Enterprise Analyzer and Micro Focus COBOL Analyzer products.

If you have one of these products installed, you can connect to the Application Analysis Server from Server
Explorer and access the Enterprise Analyzer web client. Enterprise Analyzer web client provides quick
searches for repository objects, detailed code searches, diagrams, reports, and data item impact analysis
and other features such as viewing and editing of business rules (separate license required).

Code Analyzer Refactoring
Back to Top

Support is now available for extracting program logic from COBOL code and moving it to a new program.
The following commands are available from the editor context menu:

• Create program from Section
• Create program from Computation
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• Create program from Condition

In Eclipse, you can now refactor your code using the Extract to Section command available from the
Refactor menu.

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

• DISPLAY-AT - specifies a default foreground and background color for DISPLAY AT and ACCEPT AT
statements that do not specify any color attributes.

• DPC-IN-DATA - controls whether the DECIMAL-POINT IS COMMA clause (if specified) is applied to the
output from the XML GENERATE and JSON GENERATE statements.

• ILCONDITIONPARAM - switched on by default. Enables the support for conditional expressions as
method parameters.

Important: Applications that use the old COBOL syntax for specifying named parameters as
custom-attributes will not compile with the ILCONDITIONPARAM specified. This can result in any
older applications failing to compile in the current version of the product. See
ILCONDITIONPARAM for details about how to work around this issue.

The following Compiler directives have new options:

• CHECKREFMOD - now takes an additional parameter (NOZEROLENGTH), which acts as
CHECKREFMOD, but does not permit reference modifier lengths of zero.

• PROTOTYPE - now supports options that specify whether prototypes are required, and the severity of
error messages issued for prototype mismatches.

Containers
Back to Top

Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.

Database Access - DB2 ECM / HCO for DB2 LUW
Back to Top

Support for the following has been added to this release:

• Multi-row fetch (MRF) and insert (MRI) statements with or without the FOR ROWS clause
• Array update and delete statements

Notes:

• These new features are supported for DB2 LUW version 11.1 Mod 4 Fix Pack or newer. Currently,
IBM does not support either of these features with DB2 LUW 11.5.

• For coding examples, see the IBM DB2 LUW documentation: Embedded SQL/COBOL Support for
MRI and MRF.

Database Access - OpenESQL
Back to Top

Support for the following has been added to this release:
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• .NET Core 3.1 with the COBOL .NET Core project templates "Console Application" and "Class Library"
using OpenESQL directive DBMAN=ADO.

Database Access - XA Switch Modules
Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

Support for the following has been added to this release:

• XA switch modules have been enhanced to enable storage of sensitive information in the Micro Focus
Vault Facility. This new functionality includes a customizable program, ESXAEXTCFG.CBL, you can use
to obfuscate xa-open strings by storing them as secrets.

Data File Tools
Back to Top

The following enhancements have been made to the Data File Editor:

• Double-byte character sets are now supported within the editor.
• Insert mode is now available when editing a formatted record, except for numeric fields.
• When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are

automatically added when editing a formatted record and you are editing in Insert mode.
• You can now load and unload structure files for an open data file.
• A ruler at the top of the editing pane can be toggled on/off.

Debugging
Back to Top

The following enhancements are available in Visual Studio:

• Debug profiles - COBOL projects now support debug profiles, a feature of Visual Studio, where a debug
profile stores a set of properties which specify how to start debugging the application. You can create
and manage multiple debug profiles available on the Debug tab in the project's properties.

• Expressions - you can now specify complex expressions in the Watch window. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Watch Window for details.

• Debugging MSS applications - a new Visual Studio configuration option, Do not stop on program
entry, is available. With this option enabled, the debugger does not stop execution on any entry to a
program in a native Mainframe Subsystem Application and continues to run until it detects a breakpoint.

This following enhancements are available in Eclipse:

• Breakpoints - in JVM COBOL, you can now access a breakpoint's properties from the breakpoint's
context menu in the editor.

• Expressions - you can now specify complex expressions in the Expressions view. The supported
expressions are: normal numeric arithmetic expression with intrinsic functions and the single use of
alphanumeric intrinsic functions. See Views in the Debug Perspective for details.

Deploying Applications
Back to Top

This release supports easier deployment of native COBOL applications from an Eclipse project. A new
page in the project's properties, Micro Focus > Build Configuration > Deploy, enables you to specify a
deploy folder and which files will be deployed. Building the project deploys certain executables and
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supporting files to this folder. In addition, you can archive and deploy the files on application servers, cloud
storage such as AWS buckets and access the application files with AWS services, and so on.

Eclipse Integration
Back to Top

The following enhancements are available:

• COBOL compile settings summary - this pane, which is displayed when viewing the COBOL project
settings at the project, folder, and file level, now indicates the settings that are inherited and the ones
that are set at that level. Settings inherited from the level(s) above are shown in <>.

• Deploy folder - a new build configuration feature in the project's properties enables you to copy build
artifacts and supporting files essential for deployment, to a particular folder.

• Context menu improvements - the editor context menu has been reorganized, where certain options
have been grouped together under a logical heading, and other redundant options removed.

• Copybook tooltips - hovering COPY statements in the editor now displays the path to the referenced
copybook.

• Collapsible statements - it is now possible to collapse IF, EVALUATE, and PERFORM statements in the
editor.

• Dark theme with COBOL and PL/I - you can enable the dark theme from Window > Preferences >
General > Appearance > Theme.

Enterprise Server
Back to Top

The following enhancements are available:

• Definition Import/Export Tool - a new utility, casesxml, has been added to enable you to import and
export enterprise server definitions. Using casesxml you can do the following:

• generate .xml files, in casesxml export format, that contain structured definitions of a region, a
CICS resource definition file, and the catalog

• import a casesxml export format .xml file to update the definitions of a region, a CICS resource
definition file, and the catalog

• IPv6 support (EAP) - This feature is in Early Adopter Program (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.

• Administrative Commands - the add command in cascertreg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).

Enterprise Server for .NET
Back to Top

This release includes the following improvements:

• SOAP web services for CICS (EAP) - an Early Adopter Program (EAP) feature. Enables you to create
SOAP web services for CICS transactions. This enables you to expose CICS transactions as SOAP
web services using IIS, including translating data between SOAP and COBOL formats, and applying
security rules.

• ELF and DCAS - Enterprise Server for .NET now provides the Digital Certificate Authentication Service
(DCAS) and supports the TN3270 Express Login Facility (ELF), also known as Certificate Express
Login (CEL).
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CICS users can be signed on to the region using TN3270-over-SSL and a client certificate. Enterprise
Server for .NET can also be integrated with DCAS-based mainframe SSO technologies such as Micro
Focus Host Access for Cloud (formerly Host Access Management and Security Service).

• EXCI enhancements - the External CICS Interface (EXCI) feature now supports channels and
containers, which allows larger requests and responses. It also includes some additional security
features. This provides an improved integration between Enterprise Server for .NET CICS and external
applications, whether standalone programs or application code running under other servers such as IIS.

• Administration ESF and LDAP-based security - the MMC Administration console now uses the
External Security Facility to control access to administration functions. The role-based security provided
with earlier versions of the MMC UI has been integrated into ESF as the default security option for the
MMC UI, but it is now also possible to use LDAP-based security and/or Windows authentication. This
provides you with more administration security options, including using the same security manager and
schema for region and administration security.

• LDAP-based security enhancements - the LDAP ESM Module for Enterprise Server for .NET offers a
number of enhancements, including fixes for bind-mode user authentication, support for the "user ID
attribute" configuration setting, support for long passwords, and the passtoken/passticket feature. This
provides a greater flexibility for organizations using LDAP-based security with Enterprise Server
for .NET. Passtoken and passticket support was also used to enable the DCAS feature.

Enterprise Server Security
Back to Top

This release provides the following enhancements:
• Micro Focus Secrets file storage permissions

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.

• Certificate wildcard support

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, server1.mycorp.com, and so on. These wildcard-
bearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.

• Improved ACL wildcard support

In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.

• PKIX compliance for TLS certificate validation

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.

• Security improvements for XML parsing

In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
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Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration
(ESCWA)
Back to Top

This release offers the following new features and improvements:

• MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/I, MQ,
and XA options, and security, is now available.

• ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.

• Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, Enterprise Server
for .NET, and security menu items.

• Usability improvements

• Starting and stopping regions from the navigation tree.
• The native menu items are not displayed if the region features are not configured correctly.
• Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.

• CICS resource support - the following resources are supported: ICEs, DocTemp, TCPIPService,
URIMap, Bundle, Pipeline, and WebServices.

• Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORs)
association with its PAC and member regions.

• Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:

• Redis cluster support
• A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.

You can also use the file to configure Lua scripts tracing on servers.
• Authentication support for the standalone Redis server.

File Handling
Back to Top

Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
microfocus/fh, using the mfsecretsadmin utility.

To ensure the Fileshare server uses the file stored in the vault, start the server with the /uv option.

IMS Support
Back to Top

Improvements are available in the following areas:

• BMP inbound and outbound message processing - full support is available for BMP inbound and
outbound message processing. Batch message processing programs (BMPs) can now access the IMS
message queue for input and output, in addition to their batch-type processing and data-access
capabilities.

• Commands - the following commands are now supported: - /START TRAN ALL, /DISPLAY Q TRAN,
and /DISPLAY STATUS TRAN.
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• DB Control SUSPEND / RESUME commands in an active system - IMS DB Control supports the
SUSPEND command while transactions are active. DB Control will block any new units of work and
allow active UOWs to complete during a quiesce. Once DB Control reaches a state with no outstanding
UOWs it suspends. Note a long running BMP may prevent a system from suspending.

This enables support for administrative tasks such as database and transaction log archiving. It also
enables the creation of new transaction logs when roll forward recovery is enabled.

• IMS BTS trace - IMS BTS trace is now visible from active SSTM and batch jobs. WIDTH and NOHEX
options have been added for additional control of trace output format.

This enables BTS output to be viewed when debugging a batch IMS application. Previously the job step
had to complete before the trace was visible. This also enables you to view the trace output in an active
SSTM job. Previously the MPR had to be stopped to make trace output visible.

• User DB handler exit - database exit support has been added for GSAM databases. This provides
programmatic control of the DB Catalog setting for a database instead of using the defined DB Catalog.
Also, this exit can process DL/I calls completely, for example, to map DL/I calls into VSAM I/O requests.
Previously, this exit was available only for full function databases.

To assist you with writing an exit, a template file, USERDB.CBL, and an explanatory text file,
USERDB.TXT, are available with your IMS classic samples.

• Visual Studio IDE support - a new context menu command, Show DBD List, for Visual Studio
projects enables you to view a list of all generated databases used by the project.

Interface Mapping Toolkit
Back to Top

Improvements are available in the following areas:

• Resource-based REST APIs - the following enhancements enable the creation of resource-based
REST APIs:

• Operations in JSON RESTful Web services can now have a customizable URI path that identifies a
resource. Operation paths have support for dynamic templating.

• API resources can now be automatically identified from COBOL groups in a COBOL program, and a
set of operations can be generated for each API resource.

• It is now possible to specify the location of interface fields in the service request or response. An
interface field can either be a parameter in the URI path, a query parameter, or be in the JSON
message body.

• Summary support for OpenAPI - the IMTK now supports the OpenAPI Specification (originally called
Swagger) which is the most widely-accepted format for REST API specifications. Features include:

• Consumption of OpenAPI 3.0 and Swagger 2.0 files for purposes of client and service generation.
• Generation of OpenAPI 3.0 files to describe the APIs of a JSON RESTful Web service.

• REST service output filtering and field selection - Enterprise Server JSON RESTful Web services
now include the following features:

• Automatic filtering of the JSON response body of a Web service by path and query parameters
received in the request URI.

• A special query parameter "$fields" that can be used to indicate that the JSON response body is to
contain only certain specified fields, and to exclude all other fields.

• REST API discovery - Enterprise Server API discovery is now supported. For a JSON RESTful Web
service, a list of all its available operations, and their URI paths, can be retrieved. This enables a client
to efficiently navigate an Enterprise Server REST Web service without having information about the
service’s operations ahead of time.

JCL Support
Back to Top
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The following features have been added to the JCL support:

• The sample printer exit in the product has been enhanced to retrieve extended information. The
structure defined by idadoutp.cpy now contains two new entries (ws)-extended-output and
(ws)-extended-data. The item (ws)-extended-output contains the version of the extended
output data; currently, this should be set to 1. The item (ws)-extended-data is a pointer, that if null
means there is no extended data; otherwise, it points to a new structure defined in outpext.cpy. That
structure contains the extended output information for a given job. This is demonstrated in the provided
sample - sampprnx.

Library Routines
Back to Top

The following library routines are new:

• MFU_GET_FILE and MFUGETF - both these routines are used with data-driven tests in the Micro
Focus Unit Testing Framework. If the .csv file under test references external data in one of its cells
(using the @file-name notation), use either of these routines to load that external file into memory
before such tests are run.

The following library routine contains new functionality:

• CBL_GET_EXIT_INFO - this library routine has been enhanced to better detect the circumstances in
which an exit procedure has been invoked.

The Micro Focus Database File Handler
Back to Top

Support for Db2 and Microsoft Azure databases has been added to the Micro Focus Database File Handler
(MFDBFH). This support is equivalent to that of the existing databases.

The following features have been added for all databases:

• I-O optimizations for sequential, line sequential, and ESDS/KSDS/RRDS files opened for output.
• Using direct connection strings to make a database connection (as an alternative to using ODBC

DSNs).
• Creation of databases using script files.
• Maintaining database configuration files with a command line utility, dbfhconfig.
• Using the dbfhdeploy utility to delete data files from a datastore.
• Database configuration files can now store confidential information in the Vault Facility.
• CTF tracing of ODBC and Vault operations.
• Recovering of locked processes or files can with the dbfhadmin utility.
• The dbfhconfig and dbfhdeploy utilities are now capable of executing commands batched up in a

response file.

The Micro Focus Unit Testing Framework
Back to Top

The following enhancements have been made to the Micro Focus Unit Testing Framework:

• You can now run unit tests against an executable file from both the IDE (new in Eclipse) and the
command line. Before you run such tests from the command line, you must initially rebuild the
executable in order to link it into the testing framework.

• You can now produce a report file that can be opened and viewed in Microsoft Visual Studio. Use the -
report:trx command line option to generate a .trx file.
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• The .csv source files used in data-driven tests can now reference external data: use the @file-name
notation in a cell to use the contents of file-name in the tests. The external source files must be
loaded into memory, using the MFU_GET_FILE or MFUGETF library routines, before the tests are run.

• Two new elements are available for data-driven tests: a data-driven setup and a data-driven teardown.
Conventional setup and teardown entry points would run multiple times during a data-driven test; these
two entry points run only once per test run.

The Microsoft Build Tools and Windows SDK
Configuration Utility
Back to Top

On Windows, the Visual COBOL setup file now installs the Microsoft Build Tools and the Windows SDK
packages, as these are dependencies for a number of features and operations of the product.

You can use the Microsoft Build Tools and Windows SDK configuration utility to view the package versions
in use in your COBOL environment. You can also use this utility to set the environment to use other
versions of these packages that you have installed.

Multi-Threaded Applications
Back to Top

This release includes the following improvements:

• Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.

PL/I Support
Back to Top

Enhancements are available in the following areas:

PL/I compiler

Improvements in the compiler make it easier to migrate existing applications to new platforms. Support is
available for:

• The GENERIC attribute on an ENTRY declaration.
• The COPY option of the GET statement.
• Assignment of an ENTRY to an ENTRY LIMITED variable.
• The INONLY attribute.
• Support for a SELECT with no WHEN or OTHERWISE modified to match IBM’s behavior.
• Support for new compile option which allows specification of the FIXED DECIMAL precision for

intermediate operations.
• The ability to use LIKE on a structure that contains * for element names.
• Built-in functions:

• New functions - FIXEDDEC and FIXEDBIN
• The TRIM built-in function to support its usage with structures.
• The VALID function - improved support when used with FIXED DEC arguments.
• Function precision of 15 or 31 (see the –bifprec compiler option)

• PL/I bytestream IO via FILEREAD, FILEWRITE, FILETELL and FILESEEK statements.
• Improved compatibility - when using DEFAULT RANGE with patterns; for use of the STRING

pseudovariable.
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• Improved support for - structures declared with the LIKE attribute where the referenced structure
members contained NOINIT attribute(s).

Improved functionality for customers using Open PL/I to develop z/OS applications is available:

• Improved compiler listing to show attributes of parameters to an ENTRY declaration.
• Improved expanded listing showing line numbers for code generated by preprocessors.
• Improved compiler diagnostics when trying to use BIT operators on non-BIT operands.
• Improved compiler diagnostics when an unqualified name is resolved to a structure member rather than

a matching non-member declaration of the same name in a parent block - Informational (I-level)
diagnostic (MFPLI01305I).

• A string indicating which compiler was used to generate the object code is now embedded in every
compiled routine to facilitate ease of upgrading and troubleshooting by customers.

• *PROCESS statements are now mapped to the equivalent Open PL/I compiler options where
appropriate.

PL/I debugger in Eclipse

Support is available for the following features:

• STEP out of the end of an ON Unit.

When stepping off the end of a PL/I ON-unit, the debugger determines which the next debuggable
statement is. This enables the setting of a temporary breakpoint so you can continue stepping through
the program upon return. Stepping through a PL/I GOTO statement from an ON-unit is supported as
well.

• Improved monitoring of variables that is not based on the procedure in which they are declared.
• Support for debugging PL/I application using Solaris (SPARC) 11.4 or later.
• PLIDUMP now generates information for STATIC variables and displays the HEAP data storage.

• Changes have been made to remove the variable scoping limitation which existed in previous releases.
Prior to this version, variable watches were limited to the procedure in which they were declared/used. If
a variable was passed to another subroutine, the debugger would only stop after returning from that
subroutine and recognizing that the variable value had been changed - so it wasn't possible to know
exactly where in the subroutine it had happened unless an additional variable watch was set in the
subroutine itself.

In this release, the variable's address and size are now being stored away for watch instead of the
procedure name and variable name. This allows the address/size to be monitored from the time it is
established until you cancel the watch. By doing this, the debugger is stopped as soon as it recognizes
a change of value - regardless of where it is in the user program.

Since the watch is active until you cancel it, it is possible to be watching an address/size which is no
longer allocated or active depending on the flow of the user program. In this situation, execution will be
stopped if/when the memory space is reused for some other reason.

PL/I EXEC preprocessor

• Information about host variable references and modifications is now available for the background
parsing.

• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation
starts or ends.

Macro preprocessor

• Supports the new SOURCEFILE() built-in function
• Improved compatibility for %DO statements
• %SDEBUG and %RDEBUG statements now indicate the line and column where the macro invocation

starts or ends
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Run-Time System

• Support is available for bytestream IO via FILETELL, FILESEEK, FILEREAD and FILEWRITE for
RECFM(U) files.

• Support for the COPY option of the GET statement.
• It is now possible to use a STATIC FIXED BIN(31) variable to control the RECSIZE of a file at OPEN

time.
• The JCL utility IKJEFT01 can now be driven from PL/I as a callable interface.

Product Documentation
Back to Top

The following functionality is new in this release:

• Online context help in Eclipse - online context Help is now the default setting for Visual COBOL.
Requesting F1 help from within Eclipse now opens the documentation available on Micro Focus
SupportLine. You can configure Eclipse to show either local or online help. See Viewing the Product
Help in the After Installing section.

Visual Studio Integration
Back to Top

The following enhancements are available:

• Support for the Visual Studio CodeLens feature (Visual Studio 2019 and later only) - CodeLens is a
clickable visual adornment ( , ) above entry points or number of references above class, section, or
paragraph names.

In Run Units, CodeLens provides the number of entry points, and also enables you to run and debug
directly from the editor.

• New formatting options - you can now specify different indents for the parent and child items in group
item data in Tools > Options > Text Editor > Micro Focus COBOL > Formatting > Data Division.

• Tooltips for END delimiters - tooltips are available for END delimiters such as end-if, end-perform, or
end-of-statement period. The tooltips show the opening statements.

• Code style preferences - a new category of preferences, Tools> Options > Text editor > Micro Focus
COBOL > Code Style, combines all Visual Studio preferences for the format and style of your COBOL
code.

• Lightbulbs - quick actions are available for inserting an end-of-scope terminator (such as END-IF), and
for extracting sections to new programs.

• Snippets - a new snippet for indexers is available.
• Uppercase mode - to toggle uppercase mode, click  (Force upper case in the editor) in the COBOL

toolbar, or enable it from Tools > Options > Text Editor > Micro Focus COBOL > Text Casing). With
this option enabled, code you insert or paste in the editor, including snippets, is forced to upper case.
This functionality must not be used with .NET COBOL.

• QuickInfo - information in the QuickInfo details is now colorized.
• Copybook properties - the Properties window now displays the full path for copybooks that are stored

outside of the project.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
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• Adis
• Application Workflow Manager
• AppMaster Builder
• Assembler Support
• Call prototyping in library routines
• Common Communications Interface
• Communications Server
• Compiler
• Database Access - OpenESQL
• Data Tools
• DB2
• Documentation
• Early warning of compatibility issues with current operating systems
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server for .NET
• Enterprise Server Security
• File Handling
• Handling of Anonymous Root Field in JSON
• HCO for DB2 LUW
• IDE
• Interface Mapping Toolkit
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• National data items in .NET COBOL and JVM COBOL code
• PL/I Support
• Rebuild required for projects unable to locate the Windows Resource Compiler
• Run-Time System
• SQL Option for DB2
• VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when

ODOSLIDE in effect

Adis

Back to the list

• In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.

3138718 (1112690)

Application Workflow Manager

Back to the list

• REST Connection function package attribute has been added, and Status Handlers for REST tools. See
"REST Function Package" in your product Help for more information.

• If the Search button is used in the Endevor attachment application, duplicate values are no longer
displayed in the resulting list.

3201329 (1117831)
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AppMaster Builder

Back to the list

• Data View preferences have been enhanced to provide a setting that limits Data View generation
searches to a single SQLDDL member instead of searching for all SQLDDL members identified by the
full SQLDDL path saved in the SQLSCHEMA file. When searching for an SQLDDL member, the
generation process searches the primary project path first, followed by SQLDDL workgroup paths.

3216343 (1119348)
• In the SQL Schema Maintenance dialog box, the SQLDDL members were not always sorted

alphabetically. This has been corrected. In addition, the SQL Schema Maintenance dialog box has been
updated with "LOAD" and "Filter" buttons that enable filtering.

3215756 (1119133)

Assembler Support

Back to the list

• A problem with the MFASM command-line processor program caused RC=4 warnings that prevented
the linker from being invoked. To correct this, the MFASM.EXE and MF370CHK.DLL modules have
been updated to produce .390 executable modules even when warnings occur during assembly.

3224507 (1119933)
• A problem that caused the &SYSNEST macro processor to be incompatible with mainframe assembler

has been fixed by reducing the system value by 1.
• A problem that caused National Language Characters in assembler listings to be echoed to the console

during assembly and appear as box drawing characters has been fixed.
• MNOTE errors are no longer treated as fatal errors. If only MNOTE errors are reported at assembly

time, the Assembler .obj file will be produced and the linker will be invoked.

3204758 (1118136)
• Invalid parameters specified in the Additional Directives text box are no longer treated as fatal errors by

the Assembler command-line processor. Previously, invalid parameters would prevent the Assembler
linker from being invoked even if the assembly was successful.

3204319 (1118090)

Call prototyping in library routines

Back to the list

The copybooks cbltypes.cpy and cblproto.cpy, provided by this system for call prototyping in library
routines, include features of the latest syntax, specifically the CONSTANT keyword. If these files are used
in conjunction with the MF directive, it should be set to the current level, 21; otherwise, you should remove
the directive, or do not use these copybooks.

Common Communications Interface

Back to the list

• The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.

Communications Server

Back to the list
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• The optional Digital Certificate Authentication Service (DCAS) feature of Enterprise Server, most
commonly used to provide single-sign-on for TN3270 clients, has been updated to address a severe
security issue. Customers using DCAS should refer to the topic "DCAS security" in the product
documentation. To determine whether your enterprise server regions use DCAS, look for listeners with
the "dcas" conversation type. DCAS listeners now require client certificate authentication by default. If
you are using DCAS with an external DCAS client such as Host Access for Cloud (formerly Host Access
MSS), and that client does not supply a certificate, you need to add the following setting to your DCAS
listener configuration: [Operation] allow unauthenticated clients=yes

Compiler

Back to the list

• "file not found" error messages now provide more information about the key the user needs to press.
The new format of the messages is as follows: "File name.cpy not found - Press [S]top/[R]etry/
[C]ontinue/[A]lter-path".

• External data and files declared in an instance context (such that is not within STATIC/END STATIC and
without the STATIC qualifier) can no longer be accessed from a static method. The STATIC qualifier is
now allowed in combination with EXTERNAL.

3216822 (1119228)

Data Tools

Back to the list

• You are no longer able to modify data in a structured record that is identified as comp-2 floating point -
an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.

3213037 (1118867)
• Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see

'Working with Different Character Sets' in the documentation for more information.

3161243 (1114482)

Database Access - OpenESQL

Back to the list

Just like other DBMS SQL COBOL precompilers, OpenESQL now follows embedded SQL standards and
disallows the use of group host variables in WHERE <column> = :hostvar clauses. In the past, this was not
flagged at compile-time, and would lead to unpredictable results when executed.

DB2

Back to the list

• There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)

Documentation

Back to the list

• The information about the -flag and warn compiler options has been updated.

3190928 (1120000)

Early warning of compatibility issues with current operating systems

Back to the list
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In order to better support modern operating systems, we are aligning closely with their operability
guidelines. We now detect previously-undefined behavior when interacting with OS level functions.

Error RTS096 alerts you to any calls to the operating system's fork() API, in a process that has directly or
indirectly called COBOL functionality, in your code.

The error gives you an early diagnosis of a situation which, if left unchecked on modern operating systems,
could lead to deadlocks, crashes or other failures at run time. These problems would often occur
intermittently and be very challenging to track down.

See the KB article https://community.microfocus.com/t5/Visual-COBOL-Knowledge-Base/fork-rts64-
Error-96-encountered-in-child-process/ta-p/1771191 for more details.

Enterprise Server

Back to the list

• IF an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_????_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.

3213379 (1118913)
• The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the

command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.

(642125)
• Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites" in the "Scale-Out

Performance and Availability Clusters" chapter in your product Help for more information.

• When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.

3223257 (1119804)

• Deferred work elements for cancel will not be processed until the End of Task. This means that the
cancel will not be processed during a user syncpoint.

3193871 (1117144)
• A problem where a failed syncpoint did not result in a failed transaction, leading to incorrect commit

states, has been fixed by changes in syncpoint processing. A syncpoint involving XA resource
managers can fail in one of three ways: 1 - During phase 1 - xa-prepare. When one of the RMs enrolled
in a LUW returns an error on the prepare, the LUW is rolled back. An application can now intercept the
EIBRESP and EIBRESP2 using the NOHANDLE option: EIBRESP = 78-EIBRESP-is-ROLLEDBACK -
82 EIBRESP2 = 78-EIBRESP2-sync-prepare - value 124 Otherwise the transaction abends with abend
code AEXJ - ROLLEDBACK. 2 - During phase 2 - xa-commit or xa-rollback. When one of the RMs
enrolled in a LUW returns an error on the commit, the LUW is left as is, and a severe error is sent to the
console. The application cannot handle this failure. (This is mainframe-compatible behavior.) 3 – A
syncpoint can also fail during the systematic xa-start called after the completion of the syncpoint commit
phase 2. Behavior in this case is unchanged; the transaction will abend with system code AEIJ -
NOSTART. This failure cannot be handled by the application.

3193283 (1117153)
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• For regions that are not TRANCLASS-enabled, the EXPIRYINTMIN attribute of the TSMODEL resource
is now supported. In addition, the LASTUSEDINT option is now supported on the INQUIRE TSQNAME
and INQUIRE TSQUEUE commands. Note that this changes the queue control record and will affect
any existing queues that were created with earlier versions of the product (affects non-TRANCLASS
regions only). As a result of this, you need to cold start the Temporary Storage and Transient Data after
applying this Patch Update. You also need to cold start any PACs that have existing TS\TD queues.

Enterprise Server Common Web Administration

Back to the list

• By default, ESCWA now runs on port 10086.
• When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique

Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.

• PAC names are now limited to eight characters or fewer in ESCWA.
• The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server for .NET

Back to the list

• Previously, it was difficult to programmatically detect an error condition in the PowerShell commands for
Enterprise Server for .NET. The commands will now throw exceptions in the event of an error.

3187426 (1116657)

Enterprise Server Security

Back to the list

• The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.

3206992 (1118359)

File Handling

Back to the list

• The supervisor password is no longer displayed when cobfsclose is executed from the command line.

3195772 (1117571)
• Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

3120656 (641976)
• Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting

Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.

• The SFF (Signed Free Form numeric) input field is now supported in the TRAILER3 operand.

3217597 (1119504)
• The calculated output length of SORT and the memory required could be calculated incorrectly when

symbols were used.

3203471 (1118031)

• File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.
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Handling of anonymous root field in JSON

Back to the list

For JSON (RESTful) service interfaces, the IMTK no longer forces the outermost (root) structure of a JSON
message body to always be a JSON object, but now also supports a root JSON array or primitive. Though
the root is obligatorily nameless in the JSON message, in the Interface Mapper the anonymous root must
now be defined in the operation's interface fields as the top-level body field. Consequently, since there
cannot be more than one input top-level body interface field nor more than one output top-level body
interface field in an operation, all interface fields that appear in the body of a message must now be
children of the top-level body field. Any non-conforming pre-6.0 JSON service interface is still supported
as-is, but conformance would be required upon any modification in the Interface Mapper.

HCO for DB2 LUW

Back to the list

• There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.

3204413 (1118115)

IDE

Back to the list

The resolved issues for Visual Studio are as follows:

• In fixed format COBOL code, lines in custom code snippets will now be automatically wrapped if they
reach the end of area A/B.

3201628 (1117874)
• Server Explorer in Eclipse and in Visual Studio now requires you to specify user names and passwords

if security is enabled to connect to the nodes. The default credentials are no longer automatically
applied.

The resolved issues for Eclipse are as follows:

• A bug that prevented adding multiple Program Breakpoints has been fixed.

3222576 (1119722)
• Environment variables with the format ${env.<name>} are now handled correctly during compilation and

background parse.

3215414 (1119077)
• A new option has been added to the Window> Preferences> Micro Focus> Debug dialog box: Ignore

breakpoints in resources within unrelated projects. When selected, this option guards against the
situation where you have identically-named programs within your workspace, and setting a breakpoint in
one could cause the other programs to break when they are debugged (if the corresponding lines are
debuggable). To continue current behavior, this option is not selected by default.

3211196 (1118694)
• Populated folders can now be used as output folders for JVM COBOL projects.

3210830 (1118646)
• A new option has been added to allow you to edit the location of a remote linked folder. It opens the

same wizard as when creating a new remote linked folder, but in edit mode.

3200758 (1117951)
• It is now possible to access a breakpoint's properties from the breakpoint's context menu in JVM

COBOL code.
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Interface Mapping Toolkit

Back to the list

• The COPYEXT directive on remote projects now works correctly.

3206621 (1118324)

JCL Support

Back to the list

• The wrong Symbol value was used when a symbol was assigned a different value following a
procedure.

3223719 (1119901)
• When replacing symbols in in-stream data, space-separated elements will be taken into account, and if

possible, the original position will be maintained.

3222942 (1119802)
• An issue where procedure COND statements were applied to the wrong procedure steps when the

procedure was called multiple times, notably the steps from the first call to the procedure when they
should be applied to steps from the specific call, has been resolved.

3222081 (1119699)
• The JCL JOB JOBRC parameter is now honored, and the correct return code set for the job.

3218927 (1119420)
• The MFFTP LCD, MGET and MPUT commands have been enhanced to process the members of a

partitioned data set.

3216865 (1119242)
• The removal of datasets with DISP=NEW because MF_UCC11=YA or MF_UCC11=M is set has been

restricted so that the DSORG, if defined on the DD Card, must match the catalog attribute. The removal
of a GDG Base by this method is prohibited. If the dataset cannot be removed and recreated, an error
message JCLCM0200S is issued.

3216471 (1119195)
• You now receive a correct error code, if an error occurs while processing the TSO RENAME command.

3215386 (1119281)
• The JCL File Action exit, MFJFAXIT, is now notified of the deletion of cataloged data sets.

3212961 (1118856)
• A problem in the public catalog API, mvscatpb, where the LRECL values for variable length files were

not validated correctly, producing false errors, has been corrected. The API will now return the catalog
record that has been changed.

3212769 (1118940)
• The incorrect changing of a VSAM data set file status from pristine to used when REPROing an empty

data set has been corrected. When REPROing records into a data set, if the source data set is empty,
the destination data set is not opened.

3212733 (1118839)
• GDG restart information is usually created only when ES_JES_RESTART=Y and MF_UCC11=Y or M;

however, by setting environment variables GDG_RESTART_UCC11_ONLY=N and
ES_JES_RESTART=Y results in the restart information for GDGs to be created. This ensures that the
dynamic setting of MF_UCC11, via the MFJUXIT user exit, can be applied to GDG versions. The
MFJUXIT user exit has been enhanced to provide a new event call, event-job-restart, which is called
when a job is restarted, and provides the option for the user exit to be notified of future event calls - one
of which is ‘event-job-ready’, where the user exit can set the MF_UCC11 value for the job (see
mfjdxit.cpy for user exit event information).
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3207134 (1118753)
• If a JOB CARD includes a USER ID and a PASSWORD that are different from the ones for the user

submitting the job, the credentials specified in the JOB CARD will be used to validate the permissions to
submit a job in place of the surrogate user.

3207055 (1118326)
• LISTDS now returns 8 if the requested dataset does not exist. Previously, it would return zero.

3204627 (1118102)
• PDS directories (PO) identified by environment values (the path to the directory starts with $<ENV-

NAME>), are now removed in the same way as those that do not use an environment value. The last
member is removed and the directory is empty.

3196118 (1117345)
• The MFJPTPCH module now supports the PREFORM and CNTRL parameters.

3194158 (1117171)
• Using MFFTP, a GET request that used SENDEOL no longer attempts EOL processing if the file is not

found. This now emulates the behavior on the mainframe. Previously, processing would cause
unexpected errors in cases where the file was not found.

3192989 (1117084)
• If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened

during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.

3186942 (1116611)
• It is now possible to export symbols from Enterprise Server and to use them in in-stream data. You can

also pass symbols on jobs submitted using the Internal Reader.

3164066 (1114816)
• When trying to export entries from a catalog that does not exist, mfcatxml will now report an error and

exit with a value of 12. Previously, it returned zero and created the catalog.

• An issue with error conditions incorrectly carried forward from one VSE job to the next one has been
resolved.

3220394 (1119913)
• The length of a SYSIN is no longer being checked unnecessarily.

3201488 (1117900)

Micro Focus Batch Scheduler Integration

Back to the list

• When running against an Enterprise Server PAC environment, mfbsijcl could return an invalid return
code to the scheduler. This has been resolved. Note that both of the following environment variables
must be present in the mfbsi.cfg configuration file in order for mfbsijcl to work with the Enterprise Server
PAC environment: ES_PAC and ES_PAC_ENDPOINT.

3215408 (1119254)

Micro Focus Directory Server

Back to the list

• UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y'.

National data items in .NET COBOL and JVM COBOL code

Back to the list
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.NET COBOLJVM COBOL code that uses IS NUMERIC tests on NATIONAL or NATIONAL NUMERIC data
items, or uses NATIONAL NUMERIC data items in programs compiled with the CHECKNUM Compiler
directive must be recompiled in this release. Compiled code from earlier products that uses such
constructs will generate a MissingMethodException error when run under this release.

PL/I Support

Back to the list

• A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

3192381 (1117048)
• The macro preprocessor loop no longer occurs when there is a "DO" statement with "BY" and without

"TO". For example, statements such as "DO J=1 BY 1" are treated as infinite loops.

3216391 (1119216)

Rebuild required for projects unable to locate the Windows Resource Compiler

Back to the list

Projects that were last built in a version prior to 6.0, and that rely on the Windows Resource Compiler
(RC.exe) need to be rebuilt in Eclipse, otherwise they may produce an error. This is due to the relocation
of RC.exe in this version of the product. Affected projects will be those that explicitly reference a manifest
file (used to include such things as cursors, fonts, and icons), and that are built directly from the command
line.

The problem is fixed if you open and build the project within the Eclipse IDE (as .cobolBuild is rebuilt to
find the new location of RC.exe). Alternatively, you should ensure that PATH contains a reference to
RC.exe if you continue to run projects from the command line.

Run-Time System

Back to the list

• Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.

3138692 (1112552)

SQL Option for DB2

Back to the list

• The XDB Service name has been shortened.

3195822 (1119897)

VALUE clause not permitted to follow items that use the OCCURS DEPENDING ON clause when
ODOSLIDE in effect

Back to the list
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If your Working Storage contains a data item with the OCCURS DEPENDING ON phrase, and ODOSLIDE
is in effect, any subsequent data items at the same or higher level must not contain a VALUE clause. If they
do, an error (COBCH1962) is now generated.

If you cannot remove the VALUE clauses from your source code or remove ODOSLIDE, contact
SupportLine.

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0, the .NET COBOL and JVM COBOL run-times reject
any program using IS NUMERIC on a NATIONAL item which was compiled with a version 5.0 or earlier
of the product. You receive a "missing method" exception. To resolve the issue, you need to recompile
any programs that use this construct in Visual COBOL 6.0.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 are
not affected.

• The COBOL editor in Eclipse might show incorrect error messages for a linked resource with file-
specific COBOL settings as the file settings are incorrectly ignored.

• When breakpoints have previously been set in a remote PL/I program in Eclipse and a new debugging
session is started for a local PL/I program, the debugger will crash. The same issue occurs if previously
set breakpoints are present on a local PL/I project and a remote debug session is started.

To work around this you need to clear all previously set breakpoints in remote (local) projects before
starting a local (remote) debugger session. You can remove the breakpoints from the Breakpoints view
in the Debugger perspective.

• The chapter Mainframe Access Installation Guide has been included with the product Help, however,
this feature is not part of the Visual COBOL product.

Installation

System Requirements

Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
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Visual COBOL and Enterprise Developer for Visual Studio

Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 1.2GB 75MB

Enterprise DeveloperEnterprise
Developer

2.3GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Visual COBOL and Enterprise Developer for Eclipse on Windows

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 3.7GB 75MB

Enterprise Developer 4.5GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.

For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/
prodavail.aspx.

• Support for development and deployment on Windows 7, Windows 8 and Windows Server 2012 has
been discontinued. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements
Note: This product includes OpenSSL version 1.1.1c.

Windows

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Visual COBOL and Enterprise Developer for Visual Studio:

You must have Microsoft's Visual Studio 2017 version 15.9.4 or a newer one or 2019 version 16.4 or a
newer one installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
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Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

Visual COBOL and Enterprise Developer for Eclipse:

The following requirements apply to both Visual COBOL and Enterprise Developer:

• The setup file installs Visual COBOL and the 64-bit Eclipse 4.8.

Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.

• Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.

• Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

• Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

Note: Eclipse does not run using Java 11.

• Visual COBOL requires:

• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.

• The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• You need to be logged in with a user-ID that has write access to the registry structure under

HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.
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• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Products
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

2. Alternatively, you can download the product from the Product Updates section of the Micro Focus
SupportLine Web site.

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:

Windows

1. Run the productname.exe file and follow the wizard instructions to complete the installation.

After Installing
Visual COBOL and Enterprise Developer for Visual Studio

You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 8.1, and Windows Server 2012. You use the Start screen to invoke
programs.) By default, the Help is available online on the Micro Focus SupportLine Web site: https://
www.microfocus.com/support-and-services/documentation/.

To see the Help:

Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Visual COBOL and Enterprise Developer for Eclipse

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

To view the help:
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• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: By default, Eclipse is configured to show the local help. See the installation notes within the
product Help, for instructions about how to switch to local help.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Installing X Windows on Windows

Some features of Visual COBOL for Eclipse and Enterprise Developer for Eclipse on Windows require an X
Windows installation, so Micro Focus ViewNowX is provided with the product. To install, run the file
ViewNow_X_Server.exe in your Visual COBOL installation. By default this will be in the
%ProgramFiles(x86)%\Micro Focus\Visual COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing

Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
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automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
© Copyright 2020 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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